
Chapter 11: The Patient Set Editor  
In the SEER*DMS database, a “patient set” is used to store all data pertaining to the same patient.  
These data include patient demographics, information on all reportable cancer/tumor/cases (CTC), 
associated admissions, diagnostic and treatment procedures, and follow-up information. Data 
summarized or consolidated from the source records are stored in patient set data fields.  The 
patient set also includes direct links to the source records that contributed the data. Refer to 
Chapter 2: Records and Patient Sets for more information related to patient set and record data. 

When a patient set is opened, either from a database search or as part of a workflow task, it is 
displayed in the patient set editor.  The patient set editor provides access to the consolidated 
patient set data fields and allows users to review data on the source records.  The editor enables 
users to view all information in the database associated with an individual patient, to resolve edit 
errors, and to modify data fields in response to follow-back queries.  

Although it is possible for two users to open the same patient set simultaneously, SEER*DMS 
prevents a user from overwriting changes made by another user.  If data fields are changed by the 
system or another user while you are reviewing a patient set, you will not be allowed to save 
changes to that patient set. You will be notified that the data have been changed and will be able 
to reload the patient set.  It is also possible to open a patient set that is associated with a pending 
worklist task.  When you open the patient set, SEER*DMS will display a warning message and 
provide a link to related worklist tasks. To avoid the duplication of effort, you should review the 
tasks prior to making changes.  For more information, please review the Saving the Patient Set 
section of this chapter.  

The features and tools of the patient set editor are described in this chapter.  Step-by-step 
instructions for applying these tools to specific worklist tasks are provided in: Chapter 12: 
Consolidating Data, Chapter 13:  Visual Editing, and Chapter 14:  Resolving Patient Set Errors.  

In this chapter, you’ll learn about 

• Features of the Patient Set Editor   

o Demographic Information Viewer 

o Diagnostic Information Window 

o Text Viewer 

o Show Differences  

o Viewing the Logic of Integrated Edits 

o Polishers 

• Resolving Edit Errors  

• Linking and Unlinking Records  

• Identifying and Removing Duplicate Patient Sets 

• Printing Record or Patient Set Data  

• Undoing Changes  

• Saving Changes to a Patient Set 

• Requesting Follow-back Information 
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Features of the Patient Set Editor  

When a patient set is opened in SEER*DMS, the data are displayed in an editor similar to the one 
shown below.  The patient set’s Demographics page is shown when you first open the patient set.    

 

You can use the links in the navigation box on the left to:  

• View each page of patient set data (Demographics and CTC pages.  Links to all CTC pages 
are displayed when you click CTC).  

• Review the patient set’s Audit Log (AL).  Each change made to a data field is documented 
in the audit log.  Audit log entries include the user or process which modified the data, the 
worklist task or system event in which the change was made, comments related to the 
change, the date and time of modification, and the original and modified value of each data 
field that was changed.  For a description of each event that may be listed in the audit log, 
refer to Chapter 2:  Records and Patient Sets. 

• View, add, or delete Image Files (IMG) containing data related to the patient set.  These 
images may contain the original data submitted to the registry. 

• View and/or resolve the Edits triggered by data fields in the patient set, as described in the 
Resolving Edit Errors section of this chapter. 

• Review or submit a request to the reporting facility for Follow-back (FB) information.  
Please refer to the Requesting Follow-back Information section of this chapter.  

• Review or submit an Abstract Facility Lead (AFL) to indicate that an abstract record is 
needed for the patient (see Chapter 21:  Managing Abstracting Assignments). 

• View Special Studies (SS) to which this record is assigned.  Add or remove the patient set 
from a special study (Chapter 28:  Special Studies). 

• View a history of communications initiated via Active Follow-up (AFUP) and information 
related to the most recent AFUP Need for the patient (see Chapter 16:  Follow-up) 

• View or add to the Comments (Cmt) stored in the patient set.  The comments include 
notes added by system users and messages auto-generated by SEER*DMS. 

• The source records can be accessed within the Linked section. To see the types of records 
or view record data from a specific facility, click the down arrow  adjacent to the facility 
ID.  To expand the list for all facilities, click the down arrow  adjacent to “Linked”.  You 
may then click one of the record types to access the record data. 

• In a consolidate task, the patient set navigation box will also include a separate list of 
Incoming Records to distinguish new records from records that were previously linked. 
Please refer to Chapter 12:  Consolidating Data for more information on linking records.  

The title bar includes the name of the current page (Demographics in the example above), patient 
set or record ID, and links to tools for viewing, comparing, and consolidating data. Links to the 
Demo Info, DX Info, and Text viewers are provided on the left side of the title bar; a link to the 
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Show Differences tool is on the right side of the title bar.  The Text viewer allows you to review 
the supporting text fields for each CTC.  Demo Info and DX Info enable you to compare 
demographic and diagnostic information in the patient set with data in the source records.  The 
Show Differences tool allows you to compare data fields on source records to the same fields in the 
patient set, and to copy values from record data fields to the appropriate fields in the patient set.  

A Data Header is displayed at the top of many patient set data pages, as shown below.  Data 
fields, including patient identifiers and vital status, that can be edited on the Demographics page 
are displayed in the header as a reference when viewing other data pages.  When you are working 
on a CTC data page, the data header will include the primary site, histology, date of diagnosis, and 
other fields defining the CTC.  If an edit is required in any of the fields in the data header, use the 
links in the patient set navigation box to access the relevant data page and edit the field.  

 

Demographic Information Viewer  

The Demographic Information viewer enables you to compare demographic data fields from all 
source records including records linked to the patient set and, if in a Consolidate task, incoming 
records being considered for consolidation.  This tool provides a convenient mechanism for 
verifying that all data pertain to the same patient and for evaluating data discrepancies.   If you 
are viewing the Demographics Information during a Consolidate task, the new records being 
consolidated into the Patient Set are listed in the Incoming Records section at the top. 

 

Diagnostic Information Window  

Use the Diagnostic Information window to review basic diagnostic data items for each CTC in the 
Patient Set.   By default, values for source records are hidden during ad hoc editing and Resolve 
Patient Set Errors tasks.  You may click Show Records to review values from the source records. 
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In a Consolidation task, use the Diagnostic Information window to review diagnostic data items 
from all source records associated with the patient set.  The consolidated values for each CTC are 
shown in bold, just above the record(s) that are linked to that CTC.   

 

The linkage of a record can be set or modified within the Diagnostic Information window.  If you 
are consolidating newly received record data into the patient set, you will use this tool to link the 
record to an existing CTC, auto-build a CTC from the record, or link the record at the patient level 
(see Chapter 12:  Consolidating Data for instructions).  If at a later time you determine that a 
record was linked inappropriately, you may also use the Diagnostic Information window to unlink 
the record or assign the link to another CTC or to the patient set.  If you change the linkage of a 
record, you must manually review and modify the consolidated CTC data fields (refer to the Linking 
and Unlinking section of this chapter for instructions). 

Close popup windows (DX Info or Text Viewer) before exiting the editor or opening another patient 
set.  The popup windows will not auto-close when you exit the editor; the data will not auto-update 
when you open a new patient set.  To prevent confusion, it is particularly important to close the DX 
Info and Text Viewer windows since patient identifiers are not displayed in these windows.  To 
close the DX Info window, you may either click the  in the top right corner or the Close button at 
the bottom of the viewer.    

Text Viewer  

The Text Viewer provides a convenient method for viewing text and other supporting data.   If the 
patient set has more than one CTC, select a CTC from the drop-down list.  All text fields for that 
CTC will be shown at once, in a read-only format.  The pull-down menu also enables you to select 
the source records linked to the patient set.   

 

You may display both the Text Viewer and a data page in the editor at the same time (you may 
need to resize the windows or show one on a separate monitor).  To close the Text Viewer, either 
click the  in the top right corner or the Close button at the bottom of the viewer (not pictured).   
Close the Text Viewer before exiting the editor or accessing another patient set in the editor.   
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Show Differences 

The Show Differences feature of the editor allows you to review discrepancies between each record 
and the patient set.  If an incoming record contains more current or complete information, the 
Show Differences tool enables you to update the patient set by copying the data from the record.  
The features of Show Differences are described below.  Additional instructions are provided in 
Chapter 12:  Consolidating Data. 

 

1. The Show Differences link is in the title bar of data pages that display fields from multiple 
records (Demographics and CTC). 

2. Show Differences displays values from the patient set on the left and values from a record 
on the right (as shown in the figure above).  By default, the first incoming record is shown 
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on the right.  A drop-down menu on the top right allows you to choose which record you 
wish to compare to the patient set (an abbreviation showing the type of record, the record 
ID, and the entity to which it is linked are listed in the drop-down menu).  Once you select 
a record, fields are shown if they differ and are not blank in the record data.   You may 
include fields with blank values in the records by clicking Show Empty Data.   Once shown, 
you may click Hide Empty Data to toggle the display of these fields. 

3. To assist in your review of discrepancies in the data, supporting text fields are displayed at 
the bottom of the Show Differences page.   

4. If there are no discrepancies between the non-blank data fields in the record and the 
patient set data fields, No Differences will be displayed in the top section of the page. 

5. Records and patient sets do not have the same set of data fields.  To allow you to compare 
record data to patient set data, SEER*DMS auto-builds patient set fields from the record 
data.  The process of auto-building is described in Chapter 2:  Records and Patient Sets. 

6. In some cases, groups of fields are displayed if the value of any field within that group 
differs between the patient set and the record.  This enables you to review supporting 
information when reviewing data discrepancies.  Data fields shown in groups include data 
related to:  census tract, course of treatment, the medical practitioner care fields, address, 
aliases, cause of death, and informants.    

7. An arrow  is displayed next to each patient set field, pointing from the record toward the 
patient set.  This arrow moves data from the record into the patient set and overwrites the 
values in the patient set.  You may also paste or type values directly into patient set fields.  
For some fields, a plus sign  is displayed to allow you to append the text from the 
record’s data field to the text in the patient set field.  The record ID and facility ID are 
automatically inserted prior to text that is copied or appended using the  and . 

8. The patient set includes multiple instances of certain data:  multiple addresses, multiple 
sets of informant data fields, etc.  If there are differences between the record and the 
patient set in fields that have multiple instances, you may either overwrite the patient set 
fields or create new instances in the patient set.  Consider the example in the diagram 
above.  If you determine that the address in the record represents a second address for 
the patient, click the arrows  next to the alternate address fields to add that information 
to the patient set.  If you determine that this is the patient’s current address, click the 
arrows  next to the current address fields to overwrite the values in the patient set. 

Viewing the Logic of Integrated Edits 

The fields involved in an edit and the logic of the edit are documented in SEER*DMS Help menus 
and in the Record and Patient Set Editors.  Select Help > Edits to use the searchable Edits 
Manager.  The Edits Manager may be used by all users to review the edits implemented in 
SEER*DMS.  Users with the system_administration permission may use the manager to review, 
add, or modify edits.    

In the Patient Set Editor, click the info link on the Edit Errors page to view the fields and logic of a 
failed edit.  To view this information for other edits, select View Edits from the patient set menu.   
Select a rule set and a rule ID from the drop-down lists.  A page similar to the one shown below 
will be displayed. 
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Polishers 

A polisher is a background utility that, according to SEER or registry-defined algorithms, imputes 
data values based on values in other fields.  A polisher executes when the value of one of the fields 
changes.  All changes made by polishers are documented in the patient set’s Audit Log.  The fields 
associated with a polisher and the polisher’s algorithm are documented within SEER*DMS.  Select 
Help > Polishers to use a searchable interface to review documentation related to polishers.  To 
view documentation for a polisher within the Patient Set Editor, select View Polisher from the 
patient set menu.  Select a polisher from the drop-down list.  A page similar to the below will be 
shown. 

 

The patient set menu allows you to Force Polish, that is, run all polishers despite the fact that the 
fields were not changed.  This feature should be used with caution.  All polishers will execute and, 
therefore, there may be unexpected changes in fields unrelated to your editing task.  If you use 
Force Polish, you must carefully review the list of changes displayed when you save the Patient 
Set.  If an undesirable change was made to the data, you should either correct the data manually 
or reverse the changes before saving (see the Undo Changes section of this chapter). 
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Resolving Edit Errors  

Requires system permission:  pat_edit; other permissions that may be necessary to resolve all edit 
errors include:  pat_edit_overrides, pat_end_task 

To check modified fields for errors without leaving the current page, click Validate. SEER*DMS will 
re-run the automated patient set edits and highlight any new or recurring errors. If a modified field 
does not contain any errors, it will be highlighted in yellow (see Chapter 7:  Edit Errors for a 
description of the color codes used in the editor).  The edits are also executed each time you go to 
a different data page or click the Save button. 

Review each error prior to making changes to a data field.  To evaluate and correct the problem, 
you must determine if a single field is causing the error or if an inter-field edit has identified a 
conflict between multiple fields.   

To review and correct edit errors in a patient set: 

1. To view all errors, click the Edits link in the Patient Navigation box. 

2. The following symbols are displayed next to each error in the S (Severity) column: 

 Critical – exclamation point is used to alert you to critical errors 

 High – directional symbols indicate the relative severity level of the other levels, the 
up arrow is used for high 

 Moderate – flat indicates moderate severity level 

 Low – a down arrow indicates a low severity level 

Note:  In SEER*DMS, if you hold your mouse over any symbol its meaning will be displayed. 

3. The following information is listed for each error: 

a. Rule Set – SEER, SEER Extended, and registry-defined sets of edit rules are 
implemented in SEER*DMS.  In addition, SEER*DMS applies system edits (SEER*DMS 
and SEER*DMS Registry) which enforce database constraints.  SEER Extended Edits 
were developed by the SEER Program but have not been incorporated into the standard 
SEER Edits.  The extended edits may relate to fields that are not required to be 
transmitted to SEER.  

b. Error ID – Edit name or identifier. 

c. Error Message – A brief description of the edit error. 

d. The Page column provides a link to a data page containing at least one of the fields 
causing the error.   

e. Action – Click the info link to view full documentation for the edit including the edit 
logic, data fields that are involved, and revision history. 

4. Click the link in the Page column to find and edit the fields.   All fields validated by an edit 
may not be shown on the same page, use the links in the Patient Set Navigation box to go 
to other data pages.   
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5. A data field is highlighted in a shade of red if it is associated with an edit that has been 
triggered.  Hold your mouse over the field’s value to view a listing of the edit errors 
associated with the field.   

6. If you are able to resolve the error: 

a. Depending on the field, you may either enter a value directly into the data field or use a 
lookup control to select the value.   

b. The color of the edited field will change when you move to another field (see Chapter 7:  
Edit Errors for a description of the color codes used in the editor).   

c. Click Validate to run the edits and to determine if your change has corrected the error.  
If the color of the field still indicates an error, hold your mouse over the field to review 
the error message. 

7. There are several edit errors that can be overridden using data fields displayed in the 
Override section of each CTC data page or by setting Reviewed data fields.  

a. SEER and NAACCR overrides are implemented as data fields displayed in the Override 
section of each CTC page.  Each override is associated with a specific edit.  If you hover 
your cursor over an override’s label, the NAACCR fieldname for the flag is listed.  If the 
field overrides SEER edits, the edit IDs will also be shown. 

b. Registry-specific and SEER Extended edits that warn of discrepancies in patient 
information can be overridden by setting the Reviewed data field on the Demographics 
page to Yes.  For example, a SEER Extended edit generates a warning if gender and 
first name do not agree.  

c. Registry-specific and SEER Extended edit errors of CTC data that are warnings can be 
overridden by setting the Reviewed field on the CTC page to Yes.   

d. There are three treatment review flags on the summary treatment data page.  Each is 
associated with a set of data fields; for example, the Radiation Review field is 
associated with the radiation fields in the summarized treatment data.  If the values of 
the associated data fields trigger the need for review, an edit error is generated and  

  is displayed next to the Summary TX link in the navigation box and next to the 
data fields on the page.  You must review those fields to ensure that the summary 
values are correct.  To view treatment data fields from all treatment pages in one 
window, click the multi-page icon  that is displayed next to each review field.  If 
changes are required, enter new values into the data fields on the Summary TX data 
page.   Set the flag to Reviewed. 

8. If information from a reporting facility is required to resolve an error, follow the 
instructions provided in the Requesting Follow-back Information section of this chapter. 

9. If you encounter a problem that you can not resolve: 

a. If you are editing the data via a worklist task, select Task > Reroute to assign the task 
to another user (see in Chapter 4: Using the Worklist for specific instructions). 

b. If you are not editing the data in the context of a worklist task, take note of the Patient 
Set ID so that you can seek assistance from another editor or return to the patient set 
after researching the problem. 

10. If you have made a number of changes, you should save your work periodically.  You must 
save your changes when completing a task.  When you are ready to save your changes, 
follow the instructions in the Saving Changes to a Patient Set section of this chapter. 
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Linking and Unlinking Records  

Requires system permission: pat_edit  

If you are consolidating data from an unlinked record that is new to this patient set, please follow 
all steps described in Chapter 12:  Consolidating Data.  Use the instructions below to make 
corrections when a saved patient set includes a record that was linked inappropriately. Prior to 
making a change, review the data on the record to determine if the record and patient set data 
pertain to the same patient.  Use the Demo Info tool to review patient identifiers from all records in 
one pop-up window.   In the same manner, manually review all CTC data to determine how the 
record should be linked.  Use the DX Info tool to view a list of diagnostic data fields stored in the 
patient set and in the source records. 

To modify a record’s link or to unlink a record completely: 

1. If a record is linked inappropriately, thoroughly review the relevant patient set and/or CTC 
data fields to determine whether you must also manually modify some data fields.  Use 
the Audit Log as a reference.  You may also want to print the patient set prior to changing 
the links.   

2. When you have completed your review, you may either use the record’s menu or the DX 
Info tool to modify the record’s link.  The following instructions involve the use of the 
record’s menu. 

a. Open the record in the editor.  Click the down arrow  adjacent to the ID of the facility 
that provided the record or expand the list of all records by clicking the arrow at the top 
of the Linked section.  Then click the appropriate Record Type label in the navigation 
box.   (Tip:  If there are multiple records of the same type, the record’s ID and 
reportability status are displayed when you hover over the Record Type.) 

b. Review the data displayed in the editor to verify that you selected the correct record.    

c. Click the  menu indicator that is displayed next to the record’s type to open the record 
menu. 

i. To completely disassociate the record from this patient set, select Unlink.  The 
record will be sent into the workflow at the point of matching.  It will follow the 
workflow route designated for a record of its type. 

ii. To link the record to an existing CTC, select the appropriate CTC from the Move To 
sub-menu (sequence number is displayed for each CTC listed in the menu). 

iii. If you wish to use the record to create a new CTC, select New CTC from the Move 
To sub-menu.  This menu item will not be available if the system is unable to build 
a CTC from a record of its type.  If you are creating a CTC from a non-abstract 
record, you should perform the appropriate Casefinding and Death Clearance 
processes prior to creating a new CTC from the record.  

iv. To link the record at the patient set level, select Patient from the Move To sub-
menu.  If the incoming record is not an abstract record and is for a new CTC, you 
should temporarily link the record at the patient level and defer creating the new 
CTC until an abstract is received.  Later, when the abstract record is received and 
used to build the new CTC, you can reassign this link to the CTC.  This will minimize 
the level of effort required to consolidate the data for the new CTC. 

3. Once the record’s link is moved, the new linkage will be indicated next to the record’s type 
in the navigation box: 
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a. If the record is linked to a CTC, “C NN” will be displayed.  This indicates that the record 
is now linked to the CTC that has a central sequence number equal to NN.  SEER*DMS 
attempts to set the sequence number appropriately, based on the central sequence 
number coded in the record and the number of CTCs in the patient set.  If you have 
multiple CTCs with the same sequence number, you should review the CTCs and 
manually adjust the sequence numbers. 

b. If the record is linked at the patient level, P will be displayed. 

c. If the record is unlinked, an X will be displayed.   

4. If you created a new CTC in step 2, determine whether any records linked at the patient 
level need to be linked to the new CTC.  In the patient set navigation box, the labels for 
newly created CTCs are shown in bold type. 

5. Perform a thorough review of the patient set data, including the data pages of all CTCs 
that were affected by the change.  You must determine whether any admissions or 
treatments need to be manually deleted from the original CTC.  If you have unlinked a 
record completely, you should verify that the patient’s follow-up information has been 
modified appropriately. 

6. Save your changes by follow the instructions in the Saving Changes to a Patient Set 
section of this chapter. 

Identifying and Removing Duplicate Patient Sets  

Requires system permission: pat_edit, and pat_delete 

Execute RPT-066A to generate a listing of patient sets which are potential duplicates (see Chapter 
24:  System Reports and Extracts for instructions to execute and open SEER*DMS reports).  An 
editor should use the Patient Lookup to search for patient sets listed on the report and determine 
whether the patient sets are truly duplicates.  Tip:  Try using CSV format for the report if you 
would like to copy-and-paste Patient Set IDs into the Patient Lookup. 

If the report’s matching algorithm falsely identified a patient set as a duplicate, indicate that it is a 
false positive using the Patient Matches section of the patient set editor.  If two patient sets exist 
for the same patient, follow the steps to consolidate all of the patient’s data into one of the patient 
sets and delete the other. 

To indicate that two patient sets identified as “duplicates” are not true duplicates: 

1. Open one of the Patient Sets. 

2. Click the  menu indicator in the patient navigation box to open the patient set menu.  

3. Select Patient Matches from the Patient Set menu.  If you have reviewed both Patient 
Sets and have determined that they are not duplicates, set Action to Not a Match.  The 
two patient sets will no longer be identified as a pair of potential duplicates when you run 
RPT-066A. 

4. Save your changes by follow the instructions in the Saving Changes to a Patient Set 
section of this chapter. 

To combine data from two patient sets and remove one of the duplicates: 

1. Review all data and compare the data pages in the two patient sets.  To view two patient 
sets at one time, use the browser’s controls to open a second window or tab.  You may 
also wish to print the patient sets before consolidating the data. 
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2. Select a patient set to retain.   Ultimately, you will want to retain the patient set that has 
the most and/or best data.  In making this decision, you should consider the following: 

a. The length of time that each patient set has existed in the system.  If one of the patient 
sets was created recently, it may have been created from one or two records.  If a 
patient set was created some time ago, it may be the consolidation of data from a large 
number of records.  The sequence of the patient set IDs and the auto-generated 
messages stored in the patient set’s Comments are useful in determining the history of 
the patient set.  (To review the comments, click CMT in the patient set navigation box.) 

b. The number of records linked to each patient set.  In patient sets created within 
SEER*DMS, this provides a rough measure of the amount of data consolidated into the 
patient set.  However, source records may not be available for patient sets that were 
migrated to SEER*DMS from the registry’s previous data management system. 

c. Compare the audit logs of both patient sets.  A patient set’s audit log documents all 
changes made to patient set data fields, including changes made by registry staff and 
those made in automated processes.  The number of changes made manually by 
registry staff may impact your selection of the “best” patient set to retain.   Print the 
audit logs for future reference. 

3. The next step involves unlinking all source records from the unwanted patient set.  
Ultimately, you will be linking these records to the other patient set.  To unlink all source 
records from the unwanted patient set: 

a. Verify that the unwanted patient set is displayed in the editor. 

b. For each record listed in the Linked record section of the navigation box: 

i. Click the Record Type label to open the record in the editor. 

ii. Record each ID on paper or in a text editor.  You will need this information to verify 
that all records are ultimately consolidated into the other patient set. 

iii. Click the  menu indicator next to the record’s type to open the record menu. 

iv. Click Unlink.   

4. To prevent additional data from being consolidated into the unwanted patient set, mark 
the patient set as deleted: 

a. To open the patient set in the editor, click Demographics in the patient set’s section of 
the navigation box.  

b. Click the  menu indicator next to the patient set ID to open the patient set menu. 

c. Click Delete Patient Set.  The patient set and all of its CTCs will be marked as deleted.  
This is a reversible delete.  However, the patient set and each CTC would need to be 
undeleted individually. 

5. Save your changes to this patient set and exit the editor (see the Saving Changes to a 
Patient Set section of this chapter). 

6. Each record will be moved into the workflow at the point of a matching task (the exact 
matching task will vary by record type).  In order to consolidate the records into the 
retained patient set, search the worklist for manual tasks initiated by these records.  
(Note:  It may take a few minutes for the auto-match to be completed.) 

a. To view the worklist, select View > Worklist.   
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b. Check the Show Unassigned box.   

c. To search for one record, type or copy its ID into the Pat/Rec ID(s) filter.   

d. To search for multiple records, click the down arrow  to expand the Pat/Rec ID(s) 
filter.  Type or copy the IDs into the text box. 

e. If there are no worklist tasks related to the records that you unlinked, use the Patient 
Lookup to search for the retained patient set.  The record may have been of a type that 
allowed SEER*DMS to auto-consolidate the data. 

7. Open and complete one of the tasks: 

a. If one or more Match-Consolidate tasks were created, open and complete any one of 
those tasks.  When selecting a Match-Consolidate task, it does not matter which task 
you select.  All of the patient’s records should be available for consolidation.  After 
completing the match, SEER*DMS will auto-close the other tasks.   Instructions for 
completing the Match-Consolidate task are provided in Chapter 12:  Consolidating Data.   

b. If there are no Match-Consolidate tasks and there is a Consolidate FUP task, open and 
complete that task. 

8. Verify that each record that was unlinked from the deleted patient set has been linked to 
the retained patient set, if appropriate.   Refer to the list of Record IDs created in step 3. 

9. Once you have linked and consolidated data from all available source records, you must 
incorporate any data from the deleted patient set that was not loaded from a record.  This 
includes data that was migrated and data that was entered manually.  Even though the 
patient set was deleted, you may open it in the patient set editor to view or print it.  If you 
wish to view both patient sets, use the browser’s controls to open two windows or tabs.  

Printing Record or Patient Set Data  

To print the patient set data fields:  

1. If you are not viewing a page of the patient set data, click Demographics in the patient 
set navigation box.  

2. Click the  menu indicator in the patient navigation box to open the patient set menu.  

3. Select Print.  

To print data fields on an incoming or linked record:  

1. Click the record’s link (Record Type) in the navigation box.  

2. Open the record menu by clicking the  menu indicator that appears next to the Record ID.  

3. Select Print.  

Undoing Changes 

Requires system permission:  pat_edit 

You may use the Undo Changes menu item to undo all unsaved changes by reloading the patient 
set from the database.  Any changes that you had saved will not be undone.  However, all changes 
are documented in the Audit Log.  If you need to reverse a saved change, manually edit the field 
and enter the original value as noted in the Audit Log. 
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To reload the patient set from the database and undo changes made since your last save: 

1. Click the  menu indicator in the patient navigation box to open the patient set menu. 

2. Select Undo Changes. 

3. Click OK to confirm. 

Saving Changes to a Patient Set 

Requires system permission:  pat_edit 

Use the steps below to save changes to a patient set that you are editing in an ad hoc editing 
session.  If you are editing data in the context of a worklist task, you must consider issues related 
to the flow of data in the worklist.  If you are saving patient set data within a worklist task, please 
refer to one of the following chapters:  Chapter 12 if you are saving data in a Consolidate task; 
Chapter 13 for Visual Editing tasks; or Chapter 14 if saving a Resolve Patient Set Errors task.   

To save changes to the patient set: 

1. Click Save.   

2. Enter comments to document your changes.  Enter general comments in the box at the 
top of the Review Changes page.  Comment fields next to the revised data elements can 
be used to add specificity.  The general and data field comments will be stored and 
displayed in the patient set’s audit log 

3. Save your changes: 

a. If you would like to continue editing after saving, click the Save button at the bottom of 
the Review Changes page. 

b. If you would like to exit the editor, click Save & Exit.   

Warning:  If you exit the editor using controls on or above the menu bar, all unsaved changes will 
be lost.  The menu bar is shown in red in the figure below.  The menus (View, Manage, System) 
and the controls in the User Bar (Search, Help, Account, Logoff) will take you to other system 
components without prompting you to save your changes.  Please refer to SEER*DMS Do’s and 
Don’t’s in Chapter 3:  Using SEER*DMS. 

 

Requesting Follow-back Information 

Requires system permission: pat_edit and fb_initiate 

In SEER*DMS, a request for follow-back information is referred to as a “follow-back need”.   If you 
determine that additional information must be obtained from the reporting facility, you should 
submit a follow-back need.  It will be added to a bundle of requests to the same facility.   

Periodically, a manager will review, edit, and send the follow-back requests to a physician or other 
representative at a facility.  Subsequently, the manager will process the facility’s responses.  

You will receive an e-mail when a response to your request is processed and the follow-back need 
is closed.  You or another staff member may update data fields based on the new information.  As 
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determined by registry policy, one staff member may be responsible for processing all follow-back 
responses, or the information may be given directly to the staff members who entered the needs.   

If you suspended a task pending the receipt of follow-back information, you must re-open and 
complete the task to allow the data to move forward in the workflow.  You must either make 
changes to data fields based on the new information or verify that the appropriate changes were 
made.  If you completed the task but need to update the patient set with the new information, use 
the Patient Lookup to search for the patient set.  Instructions for submitting follow-back requests 
and processing the responses are provided in Chapter 22:  Follow-back. 
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